
µLine F1  
 

PRECISION – LASER - INTERFEROMETER 
 
 

 

 

 

 

MANUAL 
 

 

 

http://www.statuspro.com  



 

  www.Statuspro.com   

 

  

Status Pro Maschinenmesstechnik GmbH,  

   Mausegatt 19, D-44866 Bochum, Germany 

   �: +49(0)23 27/98 81-0, �: +49(0)23 27/98 81-81 

   �: http://www.statuspro.com  

 

 

 

 

 

 

Laser Interferometer µLine F1  

 

 

 

 

 

 

User manual  

 

 

 

 

 

 

 

 

 

Bochum 2011 

 

 



CONTENTS 

  www.Statuspro.com   

 

 

 

INTRODUCTION ................................................................................................................. 1-1 

SAFETY CONSIDERATIONS .................................................................................................... 1-1 

WARNINGS ........................................................................................................................... 1-2 

PRINCIPLES OF OPERATION ......................................................................................... 2-1 

THE RULES OF LASER DISPLACEMENT MEASUREMENTS ........................................................ 2-1 

THE CONSTRUCTION OF REAL INTERFEROMETERS................................................................. 2-2 

THE INFLUENCE OF THE OUTSIDE CONDITIONS ON THE MEASUREMENT ACCURACY .............. 2-5 

THE ACCURACY OF LASER INTERFEROMETERS ...................................................................... 2-6 

Errors caused by the environment ................................................................................... 2-6 

A dead path error ............................................................................................................ 2-7 

A cosine error .................................................................................................................. 2-8 

An Abbe error ................................................................................................................ 2-10 

A laser stability error .................................................................................................... 2-10 

Other errors ................................................................................................................... 2-11 

A summary of laser measurement system errors ........................................................... 2-11 

PREPARATIONS ................................................................................................................. 3-2 

SOFTWARE INSTALLATION .................................................................................................... 3-2 

THE LASER INTERFEROMETER SYSTEM ELEMENTS ............................................................... 3-3 

PREPARING THE INTERFEROMETER TO WORK ........................................................................ 3-6 

SWITCHING THE SYSTEM ON ................................................................................................. 3-7 

GETTING BASIC INFORMATION FROM THE SYSTEM. ............................................................... 3-9 

BEAM ALIGNMENT ........................................................................................................... 4-1 

BEAM ALIGNMENT PROCESS ................................................................................................. 4-4 

LINEAR MEASUREMENTS .............................................................................................. 5-1 

MEASUREMENT SET .............................................................................................................. 5-1 

LINEAR DISPLACEMENT MEASUREMENT ............................................................................... 5-3 



CONTENTS 

  www.Statuspro.com   

LINEAR DISPLACEMENT VELOCITY MEASUREMENT .............................................................. 5-4 

Velocity graph ................................................................................................................. 5-4 

LINEAR POSITIONING MEASUREMENT ................................................................................... 5-6 

RECORDING MODE .............................................................................................................. 5-14 

ANGULAR MEASUREMENTS ......................................................................................... 6-1 

MEASURING SET FOR ANGULAR MEASUREMENTS ................................................................. 6-1 

MEASUREMENT OF ANGLE DEVIATIONS ................................................................................ 6-3 

STRAIGHTNESS MEASUREMENTS .......................................................................................... 6-4 

FLATNESS MEASUREMENTS ......................................................................................... 7-1 

PREPARATIONS ..................................................................................................................... 7-1 

ALIGNMENT OF OPTICS FOR THE FLATNESS MEASUREMENTS ................................................ 7-2 

Optical path alignment in the axis “1”. .......................................................................... 7-4 

Optical path alignment in the axes: “3”, “6”, “8”. ....................................................... 7-4 

Optical path alignment in the axes: “5” and “7” .......................................................... 7-6 

Optical path alignment in the axes: “2” and “4” .......................................................... 7-8 

STRAIGHTNESS MEASUREMENTS – 3D ...................................................................... 8-1 

SQUARENESS MEASUREMENTS ............................................................................................. 8-4 

VIBRATION MEASUREMENTS ...................................................................................... 9-1 

MEASUREMENTS .................................................................................................................. 9-3 

TECHNICAL DATA .......................................................................................................... 10-1 

SYSTEM SPECIFICATIONS .................................................................................................... 10-1 

LASER HEAD ....................................................................................................................... 10-2 

SYSTEM WORK CONDITIONS ............................................................................................... 10-2 

POWER SUPPLY ................................................................................................................... 10-2 

PC INTERFACE .................................................................................................................... 10-2 

ENVIRONMENT COMPENSATION ......................................................................................... 10-3 

 

 



INTRODUCTION 

1-1  www.lasertex.eu     

 

1  

INTRODUCTION 

 

 

 

 

 

Laser measurement system µLine F1 is a two frequency laser 

interferometer intended to be used mainly in machine geometry measurements. 

Its small size and low weight simplify transportation and make the instrument 

especially useful for service applications. Software version for Windows 

9x/NT/2k/XP and automation of many measurement processes make the 

interferometer easy to use. Software, compliant with ISO/DIS 230 and PN–93 

M55580, enable making rapports and diagrams. It is possible to choose 

statistical results processing according to norms: ISO 230-2 (European), 

VDI/DGQ 3441 (German), NMTBA (USA), BSI BS 4656 Part 16 (British) and 

PN-93 M55580 (Polish). 

Very good technical parameters of the interferometer allow using it also in 

scientific laboratories, for precision positioning, for scaling optical and magnetic 

liners, etc. 

 

 

Safety considerations 

 

The Laser Interferometer µLine F1 is a Safety Class I product designed 

and tested in accordance with international safety standards. It is also a Class II 
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Laser product conforming to international laser safety regulations. The 

instrument and the manual should be inspected and reviewed for safety 

markings and instructions before operation. 

 

 

Warnings 

 

Although the laser measurement system µLine F1 was design to be used 

in harsh environment, the following conditions must be met: 

• The laser head must not be put near strong magnetic fields. 

• The head should not be unscrewed from its base and if it is, it may 

not be put on a heat sink (e.g. thick metal plate). 

• The head must not be thrown or dropped. 

• Keep the optical components clean and avoid scratching them. 

• When the optics is dusted, clean it with pure alcohol. 

• Do not use the system beyond its work conditions. 
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2  

PRINCIPLES OF OPERATION 

 

 

 

 

The rules of laser displacement measurements 

Displacement measurements with the use of a laser interferometer allow 

obtaining the accuracy of a displacement measurements of 0.4 ppm in air and 

0.02 ppm in vacuum. The interferometer was first built by A.A. Michelson in 

1881. The simplified schematic of the interferometer is shown on fig. 2.1. 

Coherent light beam falls on a semi-transparent mirror. This mirror splits 

the light into two beams. The first goes to the reference arm and reflects from 

the reflector Z1; the second goes to the measurement arm and reflects form the 

reflector Z2.  The reflected beams meet again on the detector. Because these 

beams come from the same, coherent, source, they will interfere. When the 

moving reflector is being displaced, the frequency of the reflected beam in the 

measurement arm changes. The detector counts the frequency difference 

between reflected beams - fD (see fig. 2.1). The measured value of the 

displacement is calculated according to  

 

22
*

λλ
∗== NfL D  (1) 

                   Where:  N – number of pulses, 

                                λ - light wavelength. 
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FIG.2.1. THE MICHELSON INTERFEROMETER.  

 

The construction of real interferometers 

The main disadvantage of Michelson interferometer results from the fact 

that the detector cannot determine, whether fD is negative or positive thus, from 

the measurements the displacement of the moving reflector without the sign is 

obtained. Currently there are widely used two methods that allow getting also 

the direction of the movement. Depending on the number of light frequencies 

(wavelengths) used in the interferometer, the first is called homodyne (one 

frequency) and the second heterodyne (two frequencies) method.  

In the homodyne method, shown on figure 2.2, as a coherent source of 

light a linearly polarized laser is used. If it is two-mode laser (i.e. it generates 

two wavelengths) than one mode must be cut off with the use of a properly set 

polarizer. The polarising splitter splits the light beam from the laser into two 
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beams polarized vertically (90
o
) and horizontally (0

o
). The former is directed to 

the measurement arm and the latter to the reference one. The frequency of the 

beam in the measurement arm changes with the movement of the moving 

reflector. The polarization of the reflected beams is changed to circular with the 

use of a λ/4 waveplate. After 0° and 45° polarizers, two signals shifted in phase 

are obtained. The phase shift is +90
o
 when the measurement arm moves to and -

90
o
 when it moves from the laser.  

FIG.2.2. THE BLOCK DIAGRAM OF AN INTERFEROMETER WORKING 

ACCORDING TO THE HOMODYNE METHOD 

 

In the heterodyne method, shown on figure 2.3, two laser frequencies are 

used. Therefore a two-frequency laser is needed, e.g. a Zeeman laser. A two-
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mode laser is not suitable for the heterodyne method interferometer, because the 

difference between f1 and f2 is usually too high for an electronic counter. The 

output beam of a Zeeman laser consists of two circularly polarized beams, one 

polarized leftward and the second rightward. A λ/4 waveplate changes circular 

polarization to linear. The main difference between two described methods is 

that in the heterodyne one the beam frequency in reference arm differs from the 

beam frequency in the measuring arm. A detection path is also different – 

subtracting differential frequencies of reference and measuring arms does the 

measurement. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIG.2.3. THE BLOCK DIAGRAM OF AN INTERFEROMETER, WORKING 

ACCORDING TO THE HETERODYNE METHOD 
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The heterodyne method gives correct results only when fD does not 

exceed the difference between the laser frequencies, i.e.: f2 – f1. In reality, that 

difference, resulting from the Zeeman effect, is about 1MHz. This limits the 

maximum available velocity of measuring arm, in one direction, to 0.3 m/s. The 

next disadvantage of the heterodyne method is, that two frequencies must be 

used for measurements, while in the homodyne method the second may be used 

for measuring e.g. a second axis.   

 

The influence of the outside conditions on the measurement 

accuracy 

 

According to equation (1) an interferometer’s unit of measure in length 

measurement is laser’s wavelength. From definition 

 

f

v
=λ   (2) 

 

a wavelength depends on laser’s frequency f and the speed of light v in the 

measuring path. If the measurement is done in vacuum, than ν = c = 3*10
8
 m/s. 

The speed of light in a medium other than vacuum (e.g. air, water) is lower and 

is described as  

 

n

c
v =    (3) 

                 Where: n – a refraction coefficient. 

 

Normally the refraction coefficient n is a complex variable or even a 

tensor, but for less accurate calculations it is simplified to a constant. The air 

coefficient depends mostly on the pressure P, temperature T and humidity H. 
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The dependence nT,P,H, for the air was empirically determined by Edien and is 

described as 

 

n
T

TP
Pn HPT ∆+

+
−+

=−
−

−

*003661,01

)*00997,0613,0(**101
*10*8775,21

6
7

,,  (4) 

TeHn *057627,09 **10*033,3 −−=∆  (5) 

 

From the above equations one may obtain the refraction coefficient 

dependences on T, P and H in usual conditions (T=293K, P=1000hPa, H=50%): 






−=
∂
∂ −

KT

n 1
10*93,0 6  









+=

∂

∂ −

hPaP

n 1
10*27,0 6  






−=
∂
∂ −

%

1
10*96,0 8

H

n
 

It is worth to notice that the most critical parameter is the temperature, 

because its change influences the coefficient n more than changes in the pressure 

and much more than changes in the humidity. 

 

  

The accuracy of laser interferometers 

 

Errors caused by the environment  

 

The most impotent source of errors in machine geometry measurements is 

the temperature (or more exactly, the change of the temperature) of the 

measured machine. For example, if the machine’s base is made of steel, than the 

base’s length increases 11.7µm when its temperature changes 1K. It shows how 

important it is for very precise measurements to measure the temperature of the 

controlled part of the machine and to use it in readout corrections. This is not a 
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simple task for a few reasons, but the most important one is that, than when the 

machine operates, there are temperature gradients on it. That means that more 

than one temperature sensor is needed and that the more sensors are used the 

better accuracy can be achieved.  Moreover the shape of the measured part of 

the machine may “absorb” a part of the expansion of the material or the part 

may be built of materials of different expandability. 

As was mentioned in the previous chapter, the temperature influences the 

accuracy also as it changes the refraction coefficient of the medium the 

measurements are made in (usually it is air, but may be e.g. water). An Edien 

equation was presented, showing how the refraction coefficient of the air 

changes with the change of the air temperature, pressure and humidity. The 

errors caused by the change of the wavelength are less important than the 

mentioned above, but they cannot be abandoned. Roughly, a 1ppm error (i.e. 

1µm/m) is caused by: the air temperature change of o 1K, the air pressure 

change of 4hPa and the air humidity change of 30%. 

 

A dead path error 

 

A dead path error is an error associated with the change in environmental 

parameters during a measurement. This error occurs when some part of the light 

path (a dead path) is not included in the temperature (both air and base), 

pressure and humidity compensation.  

The dead path of the light path is a distance between the optical 

interferometer and the base (or the null point) of the measuring position (L1 on 

figure 2.4). Let the position of the interferometer and the retro-reflector do not 

change. When there is a change in the air temperature, pressure or humidity, 

than the wavelength changes on the whole path length (L1 + L2). The path length 

changes also when the temperature of the base changes. But the correction 

system will use the correct wavelength only on the length L2 and will correct 
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only this length. The correction will not be made on a dead path L1. In this way, 

the laser system will “move” the base point.  

A dead path error is the more severe the greater is the distance between 

the interferometer and the base point. This error is especially important in laser 

interferometers where the interferometer is build-up in a common casing with a 

laser head, because it is than very difficult to reduce a dead path. 

FIG.2.4. AN ILLUSTRATION OF A DEAD PATH ERROR 

 

 

A cosine error 

 

If the laser beam is not parallel to a measured axis of a machine (i.e. the 

optical path is not properly adjusted) than a difference between the real distance 

and the measured distance occurs. This error of un-alignment is known as a 
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cosine error, because its magnitude depends on the angle between the laser beam 

and the axis of the machine (fig. 2.5). 

If, as a reflector a flat mirror is used, than the beam must be perpendicular 

to it. If the machine changes its position form point A to point B, than the beam 

stays perpendicular to the mirror, but moves on its surface. The distance 

measured by the laser interferometer LLMS, will be smaller, than the real distance 

LM, according to  

 

LLMS = LM * cosΘ (6) 

 

The above equation is valid also when as a reflector a corn cube is used. 

 

FIG.2.5. THE BEAM UNALIGNMENT AS A CAUSE OF A COSINE ERROR 

 

The only method of eliminating the cosine error is a proper laser beam 

alignment done before a measurement. 
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An Abbe error 

 

An Abbe error occurs when, during measurements, the measured part 

does not move perfectly straight and there appear angular movements, which 

cause sloping of the retro-reflector. The sloping of the reflector is the greater the 

longer is the distance between the axis of the measurement and the axis of 

movement. This distance is called An Abbe offset. Only the movements in the 

axis of the measurement are important (see fig. 2.6). An Abbe error may be 

avoided only when there are no angular movements of the retro-reflector in the 

axis of the measurements. 

 

FIG.2.6.  AN ILLUSTRATION OF AN ABBE ERROR 

 

 

 

A laser stability error 

 

As was already mentioned, in laser measurements the laser wavelength 

instability changes directly the readout from the interferometer, e.g. a relative 
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important mainly in measurements in vacuum (where a refraction coefficient is 

constant) and when a low stability laser is used (e.g. a semiconductor laser). The 

stability of usually used in laser measurement systems, HeNe gas lasers is 0.02 

ppm, so the stability error may be neglected. 

 

 

Other errors 

 

In some conditions, a noticeable error may be caused by the electronic 

part of the interferometer. As the electronics is used mainly for counting, the 

errors may be associated either with miscounting (some pulses are not counted) 

or with miscalculating (the calculations are made with finite precision).  

 

 

A summary of laser measurement system errors 

In order to show which of the errors influence the accuracy of a laser 

measurement system the most, an exemplary calculation of errors on a 1m long 

steel machine is shown on figures 2.7 and 2.8. Different scales of the charts 

should be taken into account.  
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FIG.2.7.  A CALCULATION OF ERRORS FOR A LASER MEASUREMENT SYSTEM 

WITHOUT THE COMPENSATION OF THE ENVIRONMENT 

 

FIG.2.8.  A CALCULATION OF ERRORS FOR A LASER MEASUREMENT SYSTEM 

WITH THE COMPENSATION OF THE ENVIRONMENT
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3  

PREPARATIONS 

 

 

 

 

 

 To start the measurements using the Laser Interferometer µLine F1, 

software "LSP 30 -3D" should be installed on HD of a PC computer. The 

hardware requirements are:  

- Windows 9x/NT/2k/XP system, 

- CR-ROM 

- Pentium processor, 600 MHz or better 

- SVGA graphic card making possible working with resolution 

800x600.  

 

 

 

Software installation 

 

To install the LSP program on the PC computer put the CD disc " µLine 

F1 " into the CD-ROM. The program will be installed automatically. If the 

installation does not start automatically, explore the CD and double click on 

setup.exe icon. 
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The Laser Interferometer system elements 

 

The number of elements the system consists depends on desired types of 

measurements. To the standard set (for linear measurements) belong: 

1. 1 x Laser head – Laser Interferometer  

2. 1 x Power supply - Laser Interferometer Power Supply 

3. 1 x Tripod stand 

4. 1 x Environmental Compensation Unit - (ECU)  SM1 

5. 1 x Laser head to power supply cable 

6. 2 x Magnetic holder UM1 

7. 1 x Linear interferometer IL1 

8. 1 x Linear retro-reflector RL1 

9. 3 x Basis temperature sensor T1, T2, T3 

10. 1 x USB cable 

11. 1 x Manual Strobe cable 

 

See fig. 3.1b on the next page for pictures of the elements of the standard set and fig.3.1a 

present the suitcase for transportation and storing of the interferometer system. 

. 

 

Additional elements for angular measurements are: 

1. 1 x Angular interferometer IK1 

2. 1 x Angular retro-reflector RK1 

3. 2 x Beam directing mirror ZK1 

4. 1 x Rotary table SO1 
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FIG.3.1a. THE SUITCASE FOR TRANSPORTATION AND STORING OF THE 

INTERFEROMETER SYSTEM 
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FIG.3.1b. THE ELEMENTS OF THE STANDARD SET 
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Preparing the interferometer to work 

 

The Laser Interferometer µLine F1 is supplied from autonomous power 

supply –„Laser Interferometer Power Supply”(2). Communication with a PC 

computer is performed by USB interface. Before starting the measurements 

place the laser head –"Laser Interferometer"(1) on the Tripod stand  (3) and 

connect it with the LSP power supply. Connect with the green cable (5) the laser 

head with the "Laser Interferometer Power Supply". Connect the USB cable 

(10) to male socket on the front panel of the Power Supply. The second end of 

the cable plug into the USB socket of the computer. Connect the air temperature 

and humidity sensors  (4) - (THS – Temperature and Humidity Sensors)  to the 

6-pin socket marked THS on the front panel of the Power Supply Unit. 

Temperature sensors T1, T2, T3 (9) connect to 4-pin sockets placed on the front 

panel. To 6-pin socket marked STROBE should be connected a source of strobe 

signal (11). Strobe signal may be produced by a pulse switcher (5 m cable with a 

pulse switcher is in standard set) or by any other devices. Strobe input is used to 

control the moment of measurement either by hand or automatically during 

dynamic positioning. The linear interferometer (7) and linear reflector (8) should 

be mounted in magnetic bases (6). 
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FIG.3.2.  ELECTRIC CONNECTIONS OF THE µLINE F1 

 

 

      

Switching the system on 

   

After connecting all necessary cables to the Power Supply unit, switch on 

the device according to the following instructions:  

1) Switch on the power switch in the Laser Interferometer Power Supply,  

2) Start LSP30 – 3D program on a computer. 

 

When the main menu appears at the computer monitor (fig.3.3) choose 

option Display (fig.3.6)  
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FIG.3.3. MAIN MENU 

 

 

If the program is started before the Power Supply is turned on or the 

Power Supply is not connected properly to the computer, on the monitor an error 

window with “No connection or Power Supply Off” line will appear (fig. 3.4). 

To get rid of this error quit the program, check the connection and/or the supply 

of the Interferometer (the POWER diode should be on). 

 

 

FIG.3.4. ERRORS THAT MAY OCCUR DURING SOFTWARE LOADING 
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If the interferometer is not connected to the computer an error window 

with “Could not open COM port. Check COM port settings” line will appear. 

Please check the connection between the computer and the power supply. 

 

 

FIG. 3.5. OPTION CONFIG 

 

In the option Config (Fig. 3.5) the user can change the language of the 

program (after installation it opens in the language of the installed Windows 

system). In other panels of mentioned window the user can configure many 

parameters of all types of measurements feasible with the system. These panel 

can be also reached from other parts of the program.  

 

 

 

Getting basic information from the system. 
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After proper software loading choose option Display. The laser system 

will be heated up. If the output beam of the laser is properly redirected to the 

laser head (e.g. with the use of the retroreflector RL1) the Beam Strength – the 

green indicator on the screen – will appear and disappear. The speed of changes 

will become smaller due to the increase in the temperature of the laser system 

cover. During the heating up time the measuring system is ready for the 

alignment of the optical arrangement of the laser path (see chapter 4). 

 

 

FIG.3.6. OPTION DISPLAY 

 

On the Display screen there are four panels:  

- Panel containing the digital result of the measurement, the measuring 

signal level indicator and the buttons for changing the number of displayed 

Digits and for changing Units. Quantity of significant digits on display may be 

changed with the use of buttons ↑↑↑↑ ↓↓↓↓, pressing button with an inscription Change 

changes measurement unit on the display. In the upper left corner there is an 
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icon making link to Microsoft Excel (if installed). Running this link allows to 

register measurement in Excel cells by each STROBE button press. 

- Panel Environment where measured data obtained from the 

Environmental Compensation Unit - (ECU)  are shown. On the screen there are 

shown: temperature, pressure and humidity of the atmosphere (Humidity, 

Pressure and Air Temp.) and temperatures measured by three base temperature 

sensors (Average temp., T1, T2 and T3). Average temperature of the base 

measured by three sensors is also presented. 

- Panel Measurement contains basic information about conducted 

measurement. With the left button the type of measurement can be changed. The 

right is used for choosing measuring axis. At every change of measuring option 

(i.e. distance, speed, angle, straightness) and/or change of measuring axis (i.e. X, 

Y, Z) a drawing suggesting the arrangement of the optical elements appears on 

the screen. Clicking with left mouse key in the area of the drawing invokes help 

on a theme of the optical arrangement alignment. Panel Measurement also 

contains an option Adjustment. This option is very helpful in optical path 

alignment process (see chapter 4). 

- Panel Parameters, contains a few options. Option Sign allows choosing 

whether enlarging distances between the retro-reflector and the interferometer 

gives positive (default “+”) or negative result on the display. In the option 

Material one can choose the material from which a basis of a machine is made 

of. The value of the thermal expandability coefficient of the basis is used for 

calculations of the real shift value (i.e. measured value referred to the 

temperature of 20°C). Option User makes it possible to enter any value of the 

thermal expandability coefficient. In the panel Resolution one can change 

between high (10nm) and low (100nm) system resolution. In higher resolution 

accepted movement velocity is strictly limited (see Technical data chapter for 

details). In the panel Environment the data from Environmental Compensation 
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Unit - (ECU) may be controlled. From console of the computer one can switch 

off the data coming from Environmental Compensation Unit - (ECU)  and insert 

the parameters of the atmosphere by hand.  

When measurements are executed with automatic compensation of the 

atmosphere parameters and the compensation of the basis temperatures one 

should: 

- place the air temperature and humidity sensors THS on the machine in 

the vicinity of the laser beam. 

-  place the sensors of the basis temperature along the measured axis on 

the machine basis 

Measurement executed without automatic compensation are referred to 

normal conditions: temperature 20 °C, pressure 1016 hPa, humidity 50 %.  
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4  

BEAM ALIGNMENT 

 

 

 

 

 

 

 

The LSP-3D provide unique functions: Alignment and Laser Head 

which are very useful tools for the laser beam alignment. Beam alignment is a 

process in which the user, with the use of certain mechanical arrangements, 

makes the direction of the laser beam parallel to the direction of the movement 

in a measured axis. If the beam is not correctly aligned an effect like the one 

shown on Fig.4.1 may happen, i.e. the position of the beam returning on the 

detector in the laser head from the moving retroreflector may vary with the 

position of the retroreflector resulting in a cosine error (see chapter 2) and/or 

misalignment of the optical path (no Beam Strength). 

 

 

 FIG.4.1. ILLUSTRATION OF BEAM ALIGNMENT 

 

The alignment of the optical path is the most difficult and laborious part 

of the whole measurement process. Be very careful reading this chapter!  
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The alignment of the optical set up should be conducted in option 

Display. It can be done during laser head heating. Final check should be made 

when the system is ready to work. 

The Laser Head should be firmly attached to the tripod. The tripod should 

not touch a machine as it may cause vibration of the laser head and the optical 

path. Turn special attention, not to move the legs of the tripod during the 

measurements, because it will cause shift of elements of the optical path and the 

necessity of repetition of the alignment process.  

 

 

 

FIG. 4.1 ILUSTRATION OF THE FUNCTION LASER HEAD 
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The arrangement of the tripod helps to adjust the optical path. Inspection 

of the level of arrangement can be made using level fastened on the tripod. The 

angular position of the laser head is set using the function Laser Head. The 

tripod must be levelled, and after that with the function Laser Head the position 

of  laser head must be set according the angle of measuring path. In the most 

application the laser head is levelled. In special cases, when the measuring path 

is sloped to the level, the angle of slope must be set. The angle of rotation of 

laser head must be set to zero degree (90  degree in some configuration). The 

diaphragm of the laser beam on the front panel of the laser head helps in the 

process of alignment. The diaphragm can be placed in three positions:  

- Right extreme position (fig. 4.1a)  –" Alignment" – the laser beam 

goes out through opening in the diaphragm about 2 mm diameter,  

- Central (fig. 4.1b) –" Measurement" from the laser head goes out 

beam about 8 mm diameter, 

- Left (fig. 4.1c) - extreme position, in which the exit of the beam from 

the laser head is completely closed.  

 

 

FIG.4.1. DIAPHRAGM POSITIONS. A) RIGHT, B) CENTRAL, C) LEFT 
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During transportation or when system is not used, correct position of 

diaphragm is left extreme position. In this position optics is safe from getting 

dirty, covering with dust and accidental damage during transportation.  

 

 

Beam alignment process 

 

1. In the option Display in the PC program choose type of measurement, 

which will be done and axis along of which measurements will be carried. On 

the screen will appear a drawing showing recommended arrangement of 

measuring elements at the chosen type of measurement (Fig. 3.6).  

2 Linear interferometer IL1 and linear retro-reflector RL1 should be 

mounted on magnetic holders UM1, UM2. Regulating elements 

(see Fig. 4.2a, b, c) of the laser head should be placed in central positions, to 

assure maximum range of regulation.  
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FIG.4.2.  THE LASER HEAD ALIGNMENT ELEMENTS 

 

3. Choose which from the optical elements will be moved (retro-reflector 

RL1 or interferometer IL1) and attach both with magnetic holders: one to a 

moving element of the machine, second to an element in relation to which 

displacement will be measured (for example: the retro-reflector may be fasten to 

a moving element, and the interferometer to a motionless table). Remember, that 

relative linear displacement between the retro-reflector and the interferometer 

is measured. 

Z Aligment 
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Attention! It is inadmissible to place one of optical elements (i.e. RL1 or IL1) 

outside the machine on an additional stand – the system measures then also 

displacements of the machine in relation to the stand!!!).  

4. The moving element of investigated axis should be moved as close as 

possible to the position of the laser head and the tripod.   

5. Place the interferometer optics IL1 and the retro-reflector RL1 on the 

axis of movement. If the axis of movement is horizontal check the level 

indicators (Fig. 4.3) on the laser head and the interferometer. In both cases the 

blob should be inside the inner circle. 

Attach the retro-reflector RL1 to the interferometer IL1 (there is a special 

socket for this purpose in IL1) – see fig.4.3. 

  

 

FIG.4.3. START POSITION OF ALIGNMENT 

 

6. Move the moving element of the machine together with the attached 

optical element to the opposite, extreme position. Diaphragms on IL1 and RL1 

and of laser head place in position – “Alignment” (Fig. 4.4a).  

Level 
indicator 
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FIG.4.4. ALIGNMENT POSITION (A) AND WORK POSITION (B) 

 

7. Regulate the tripod height and level of the laser head by means of a 

sphere joint. The laser beam has to fall on the upper hole of the interferometer 

diaphragm and after passing by the hole must be found within diaphragm area of 

the retro-reflector. The laser head should be placed horizontally (for horizontal 

axes) – control it on the level indicator.  

8. Using regulating elements of the laser head (Fig. 4.2) find a position in 

which laser beam passes through both upper holes in the diaphragms placed on 

the interferometer and the retro-reflector. The spot position on the diaphragm of 

the interferometer (the interferometer is placed closer to the laser head) – should 

be regulated with X stage and up-down translation stage Z and up-down 

translation of the tripod. The spot position on the retro-reflector diaphragm (the 

retro-reflector is far from laser interferometer) – should be regulated with “α” 

angle alignment in vertical and “β” angle alignment in horizontal line. 

9. Switch the diaphragms on RL1 in a position “Work”.  

10. Using the regulating elements of the laser head adjust the position of 

laser beams on the diaphragm of laser head. Two return beams should exactly 

cover each other on the entrance hole on the front panel of the laser head during 

A B 
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the whole movement range. If this is necessary gently correct the position of the 

IL1. Shift the diaphragm on the laser head to the position “Work”. The level of 

the measuring signal (the green indicator on the screen of the computer) should 

have value not less than 80 % during translocation of the moving element along 

the whole path.  

11. For precision alignment, when the straightness measurement will be 

carried on, use electronic alignment. Switch screen of the Display to Adjustment 

mode. Move the machine to the position where the optical elements are closest 

to themselves. Then, using horizontal and vertical alignment screws set two 

crosses, blue and green, to the centre of the screen. Blue cross corresponds to  

the reference beam while the green one to the measuring beam see Fig 4.5. Now 

move the machine to the position where the distance between the optical 

elements is the highest. Check if the crosses are still in the same place when they 

were in the former position.  

 

FIG.4.5. CORRECT ALIGNMENT OF OPTICAL PATH 
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FIG.4.5. INCORRECT ALIGNMENT OF OPTICAL PATH 

 

If they are not, correct the position of the laser with screws responsible for 

angular movement. 

12. Reset displayed position using “Reset” button on the display. System 

is ready to work.  

 

Attention! Remember, that the position when the interferometer touches the 

retro-reflector can serve only to adjust. Be sure that during measurements in 

extreme nearest measuring position the retro-reflector does not touch the 

interferometer, because it can be a source of measuring errors.  
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5  

LINEAR MEASUREMENTS 

 

 

 

 

Measurement set 

 

Linear measurements are the most often used measuring option. Using 

this option it is possible to measure:   

- Linear displacement;  

- Velocity of moving element; 

- Linear positioning; 

- Vibrations (see Chapter 8); 

- Straightness (see Chapter 9). 

Measurements may be executed in three mutually perpendicular 

measuring axes X, Y, Z. Change of a measured axis will demand realignment of 

the optical path.  

 

Required measuring set: a computer, a laser head with a power supply, a 

tripod, two magnetic holders UM1 (or two UM2), an Environmental 

Compensation Unit (ECU) - SM1, basis temperature sensors T1, T2, T3, a 

linear interferometer IL1, a linear retro-reflector RL1 and, optionally, remote 

control Strobe.  

.  
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FIG.5.1 SET UP FOR LINEAR MEASUREMENTS IN X AXIS 

 

 

FIG.5.2. SET UP FOR LINEAR MEASUREMENTS IN Y AXIS 
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FIG.5.3. SET UP FOR LINEAR MEASUREMENTS IN Z AXIS 

 

 

Linear displacement measurement 

 

When one wants to prepare the measurement system for the measurement 

of a linear displacement, electric connections and alignment of the optical path 

(see chapter 4) must be carried out. When the laser system is ready to work – 

green LED light on the forehead of the laser head will be on. Next, it is 

necessary to check optical path, i.e. whether the measuring signal value shown 

in the Display option as Beam Strength is at least 80% on the entire axis. The 

measurements now can start. A measuring unit (mm, µm), a number of 

significant positions on a display, a measured axis, a sign (“+” or “-“) and base’s 

material can be chosen. After resetting, the display system is ready for 

measurements. When the retro-reflector is moved,  on the screen the 
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displacement in relation to the starting point is displayed (it is also possible to 

move the interferometer in relation to the standing retro-reflector). 

 

 

Linear displacement velocity measurement 

 

The arrangement of the optical path and the laser head should be the same 

as in the paragraph above. The measurement of the linear displacement velocity 

is executed in option Display. The type of measurement should be changed to 

Velocity and a unit should be chosen (m/min, m/s). After resetting the result on 

the display, system is ready for the velocity of displacement measurement. 

During translocation of the retro-reflector the value of velocity is presented on 

the screen.  

 

 

Velocity graph   

 

The arrangement of the optical path and the laser head should be the same 

as in the paragraph above. Velocity graph can be activated in the Main Menu 

by choosing the option Velocity. The screen will look like shown on the 

Fig. 5.4. When the measurements are to be started the button Start should be 

pressed and the object, which displacement velocity we investigate, should be 

moved. To finish the velocity measurements the button Stop should be pressed. 

On the screen the velocity graph will appear. By clicking on a part of the graph 

and moving the mouse rightwards the graph can be zoomed. By clicking on a 

part of the graph and moving mouse leftwards the zoom is cancelled. The graph 

can be printed or saved to a file. This can be done by choosing from the upper 

menu File, and then suitable a option (i.e. Save, Save as, Print).  



LINEAR MEASUREMENTS 

5-5  www.statuspro.com      

         

FIG.5.4. VELOCITY GRAPH WINDOW 

 

An example graph of changes of the linear displacement velocity of a 

machine table in one axis is presented on fig. 5.5. 
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FIG.5.5. EXAMPLE GRAPH OF CHANGES OF LINEAR DISPLACEMENT VELOCITY 
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Program also calculates an average velocity from a visible range on the 

graph. It is also possible to preset minimum and maximum values for measured 

axis. Clicking left mouse button on selected axis or clicking right mouse button 

within the area of the graph appears a menu, from which a proper axis can be 

chosen. On the screen a window with options Velocity scale and Time scale 

will appear. Scaling can be set as automatic or set to maximum or minimum 

values. 

Program makes it possible to saving the velocity graph and then load it for 

example to a Word editor. To save graph to the file we should click with the 

right mouse key within the area of the graph. From the popup menu that will 

appear the Copy to clipboard option should be chosen. 

The choice of the speed unit is also possible: from menu Edit we should 

choose option Config, where the velocity unit can be set.  

 

 

Linear positioning measurement 

 

The linear positioning measurement is the most advanced option of linear 

measurements. It is the most common form of laser measurements performed on 

machines. The system measures linear positioning accuracy, repeatability and 

backlash by comparing the position to which the machine moves (i.e. the 

position displayed on the machine’s readout) with the true position measured by 

the interferometer. In order to start measurements the option Main Menu should 

be activated and the Positioning button should be pressed. On the screen will 

appear a window Linear positioning as presented on the fig. 5.6 
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FIG.5.6 LINEAR POSITIONING WINDOW 

 

 The upper menu of this window consists of options: File, Edit, 

Measurement, View, Help. In the option File there can be found instructions for 

reading measured data from a file, saving the data to a file and printout of 

measurements results.  

 

 

FIG.5.7 MACHINE DATAWINDOW 
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Option Edit allows to enter data of the measured machine (Fig 5.7), 

preview of measurement results in every cycle of positioning and edition of 

positioning points (when option Target Points from List from menu 

Measurement is active).  

 

 

FIG.5.8 MACHINE ERROR LIMITS WINDOW 

 

In the Edit option the user can also setup allowable error limits of the 

machine for different norms (option Machine error limits - Fig. 5.8). The 

results of the whole linear positioning measurements are compared with this 

limits (see Fig. 5.10). This option is especially useful when there are checked 

many machines of the same type and the same requirements on their accuracy. 

In the panel Positioning of the Config window the user can set up 

important options of the linear positioning measurements (Fig. 5.9). There are 

three available ways of checking machin’s positioning: Linear, Pilgrim1 and 

Pilgrim 2 (buttons in Measurement method panel). The directions of the 

expected movement of the machine are shown on the pictograms. Usually the 

Linear method is used.  
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FIG.5.9 LINEAR POSITIONING CONFIG WINDOW 

 

In the Cycle number the user can set how many complete measurements 

cycles are to be performed. The more cycles is chosen the better results will be 

achieved. 

Max Acceptable Error is an option where the user can set the maximal 

acceptable error level above which the software will communicate to the user 

about a machine error. 

Options Point capture after and Vibrations are valid only when an 

automatic point capture is chosen. By changing these options the user can decide 

after how much time a trial of automatic point capture should be made by the 

program and what is the acceptable level of vibration (level of vibration depends 

mainly on the measured machine). 

Min Points Interval describes minimal distance between positioning 

points. 
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Option Measurement includes the options connected with the process of 

measurement:  

Start – beginning of measurements  

Stop – break of measurements  

Automatic Point List Generation – this option is marked when the 

positioning points are calculated automatically by the program and not chosen 

by the user (see below) 

Target Points From List – after choosing this option on the screen 

appears a window for edition measuring points in which we write or count 

distance value for positioning points. If this option is not active then the 

positioning points are marked automatically in first measuring cycle and the 

option Automatic Points List Generation is marked.  

Stop After Cycle – if this option is active program breaks the 

measurement after realization of a measuring cycle; if it is not active the 

configured number of cycles is executed.  

Manual Capture – choosing this option causes that for measuring points 

the measured displacement value is registered by the program after pressing a 

button Manual Capture or a pulse switcher Strobe. If this option is not active 

than points are captured automatically (program detects the moment of machine 

stop).  

Target Position Correction – setting this option gives possibility to 

change an earlier defined distance value of a measuring point during the 

measurement process. Before point capture appears a window in which can be 

written new distance value whereupon marked are only places after comma what 

causes that it is not necessary to write all distances.  

 

Option View serves to switching on or off a panel Target Position, Error 

Table and to switching on drawing on the graph of measuring points from all 
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cycles (active cycle is drawn using solid line but remaining cycles are illustrated 

using only points).  

 

If system is ready to work, then on the screen appear two digital displays 

and gauge of measuring signal level (Fig. 5.6). On the upper display the 

measured value is shown. On the bottom display the value of the target position, 

read from data points table or appointed automatically, is shown. Under the 

displays on the left side there is shown a graph on which the results of 

measurements are shown. On the right side an Error Table can be found. Under 

the graph two buttons can be found: Start - beginning of the measurement and 

the button Main Menu - allowing to re-enter the Main menu. 

In the bottom parts of the window a status bar can be found, on which 

there is presented a configuration of the positioning measurements. In the first 

field the information about the method of measuring points capture is placed 

(manual, automatic). In second field information whether measuring points 

originate from list or are marked automatically is shown. The next field informs 

about number of cycles in series (number of cycles executed one after one, if not 

active is the option Stop After Cycle). 

To execute the linear positioning measurement, the program has to know 

the target position in which it has to make measurement and where it has to 

calculate deviation from an expected value. The positioning points can be 

automatically defined in the first measuring cycle on a condition that distances 

between points are marked with an accuracy of 1.000mm. The positioning 

points can be also written or calculated after marking an option Target Points 

From List. After activating this option the positioning points can be defined in 

any accuracy.  

Measurement can be done in an Automatic option or in a Manual 

Capture option. In the automatic version the system itself recognizes the 
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moment of stop, the value of target point, the direction of movement and the 

series number.  

For correct operation of the automatic option below rules should be 

followed:  

1) The time of machine stand still duration in a positioning point  must be 

no less then 1 second – default value (this can be changed in the Config->Max 

Accaptable Error),  

2) Vibrations of the target  should be less then 10 µm - default  value (this 

can be changed in the Config->Vibrations),   

3) After every pass the target should be moved at least 2 mm away from 

the last positioning point, stopped until capture and, after it,  returned to the 

last positioning point  - this procedure is necessary for correct backslash error 

measurements.      

If vibrations are too large and system does not capture points – then the 

option Manual Capture should be switched on in the menu Measurement. 

After choosing the Manual Capture option on the bottom of the screen appears 

an additional button Manual Capture. Capture of the measuring point takes 

place by pressing this button or pressing the button on the impulse switcher.  

Examination of linear positioning of machine consists of at least 2 

measuring cycles. In every cycle the measured machine will move the retro-

reflector for programmed distance fore (Avers) and back (Revers). After each 

shift the machine should stop for a time at least one second. The measured 

distance by the laser system is saved in the table of results. After at least three 

series of measuring cycles, statistical calculations can be executed and the report 

from examination is prepared. In order to get the final report press a button 

Report. Using buttons Remove and Add it is possible to change the measuring 

cycle in which accidental error is suspected. The screen of the computer after 

pressing the button Report is presented on fig. 5.10 
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FIG.5.10. LINEAR POSITIONING RESULTS 

 

The positioning parameters are presented on the graph. In the right side 

panel Results is found, on which the results of statistical calculations, the norm 

according to which calculations were executed and the limit values for the 

certain machine are presented. If the error value exceeds set limit for the 

machine this error is displayed in red. The norm can be chosen from a list. After 

choosing a new norm the results are recalculated.  

 

 

Under the graph there are: buttons used for change of the axis scale Axis 

Scale (automatic scaling or assignment, minimum and maximum values), 

choosing of parameters shown on the graph Parameters, report, printout Print 

and return to looking through the measuring cycles Previous Menu.  

Example of linear positioning report of CNC machine in axis is presented 

on fig. 5.11  

 



LINEAR MEASUREMENTS 

5-14  www.statuspro.com      

              

FIG.5.11 LINEAR POSITIONING REPORT 

 

Recording mode 

 

The long term changes of the length of machine axes under changes of 

temperature condition may give the information about thermal properties of the 
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machine. This kind of measurements called “Recording mode” may be chosen 

by pressing RECORD button on the Display screen. This switches the system 

into the mode of the data recorder. The time interval of the records could be 

programmed from the computer by setting a required value.  

 

 

FIG.5.12 RECORDING DATA MODE 

 

Pressing “End Recording” finishes the data recording. The results can be saved 

with the choice of “Save to file”. In fig. 5.12 the example of Data Record is 

presented. 

 

Flat mirror measurements - option 
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       The flat mirror measurements permits the measurements of displacement, 

velocity, positioning and vibrations of a flat surface. The surface should have 

mirror quality (surface flatness λ/8) and the reflection coefficient not less 50%. 

The aluminium, gold or dielectric mirror mounted to the moving part is 

suggested. There are two possible configuration: double pass setup Fig. 5.13 a 

and single pass setup 5.13.b. The resolution of double pass setup is two time 

bigger then one pass. The setup consist from the laser head, the flat mirror 

interferometer FMI and the flat mirror.  One have to chose the single/double 

pass option on the screen in display mode to have correct result of measurement.  

 

FIG. 5.13 a  DOUBLE PASS FLAT MIRROR INTERFREOMETER 

 

 

FIG. 5.13 b  SINGLE PASS FLAT MIRROR INTERFREOMETER 
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6  

ANGULAR MEASUREMENTS 

 

 

 

 

Measuring set for angular measurements   

 

The angular measurements performed by the laser interferometer system 

are used for straightness, surface flatness and angular positioning of rotary 

tables. Straightness measurements can be done in three mutually perpendicular 

axes X, Y, Z.  

 

                     

FIG.6.1. SETUP FOR ANGULAR MEASUREMENTS IN HORISONTAL  X-AXIS 
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Change of measuring axis will demand displacements of angular optics 

( figures 6.1, 6.2 and 6.3 ). 

 

 

FIG.6.2. SETUP FOR ANGULAR MEASUREMENTS IN VERTICAL X-AXIS 

 

 

FIG.6.3. SETUP FOR ANGULAR MEASUREMENTS IN Z-AXIS 

 

Required measuring set: a computer, a laser head with an interferometer 

power supply, a stand Tripod, two magnetic holders UM1 (or UM2), a 
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Environmental Compensation Unit - (ECU)  SM1, sensors of basis temperature 

T1, T2, T3, an angular interferometer IK1, angular retro-reflector RK1 

mounted on P100 mm base, remote control Strobe (option).  

Auxiliary equipment used in the angular measurements is: two mirrors 

ZK1 mounted on supports, serving to reflect the laser beam - necessary to 

measurements of the surface flatness; a rotary table SO1 controlled by step 

motor - used to angular positioning measurements.  

 

Measurement of angle deviations 

 

Preparations to measurements are similar to those described in the 

previous chapter. The measurements are executed in Display mode. The type of 

measurements should be set to Angle and a suitable measured axis should be 

chosen (fig. 6.4). It is accepted that when the retro-reflector is bent towards the 

laser head direction, measured value is positive. It is possible to change the sign 

in the panel Parameters – Change of sign.  

          

FIG.6.4. ANGLE DEVIATIONS MEASUREMENT SETUP 
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After Reset Position the system is ready to measurements. If the retro-

reflector is moved to a new point and on the screen the value of the angle 

deviation in relation to the first point is shown. It is also possible to measure 

change of the angle deviation in the same point if the inclination of retro-

reflector changes. 

 

Straightness measurements 

 

The straightness measurements are driven along a straight line to which 

side surface of the angular retro-reflector base is tangent. In order to get the 

correct measurement the straight ruler, along which retro-reflector base will be 

pushed, should be fasten on a measured axis. In every moment of the 

measurement side surface of the retro-reflector base should be tangent to the 

ruler (see fig. 6.5). 

  

FIG.6.5. AN EXAMPLE OF OPTICAL COMPONENTS SETUP IN STRAIGHTNESS 

MEASUREMENT 
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Required measuring set: a PC computer, a laser head with a laser 

interferometer power supply, a stand Tripod, two magnetic holders UM1 (or 

UM2), a Environmental Compensation Unit - (ECU)  SM1, sensors of basis 

temperature T1, T2, T3, an angular interferometer IK1, an angular retro-

reflector RK1 on a support base P100 mm, a remote control Strobe.  

The Straightness measurement is based on pushing angular retro-reflector 

about an interval 100 mm and measuring its angle deviation. Before beginning 

to the measurement, measuring points should be marked every 100 mm distance 

on the leading ruler or on the examined surface. It is recommended using ruler 

with scale. The straightness measurement is performed in the option 

Straightness, chosen from Menu Main (fig. 6.6). 

 

         

FIG.6.6. STREIGHTNESS MEASUREMENT WINDOW 

 

The measurement can be done in an automatic mode (standard 

arrangement) or in a manual mode with manual capturing of measuring points.  

In the automatic mode capturing of the measuring points takes place when 

a temporary time interval runs out. The time between capturing the measuring 
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points is used to move the retro-reflector about a distance of 100 mm. The time 

interval should be used in dependence from practices of a person leading the 

measurements. It is suggested to set the time on 10 s and to decrease it if needed. 

An arrangement of the time interval may be done by pressing ← , →  keys on 

the computer screen . The retro-reflector base P100 should be placed at the 

beginning of the examined axis close to the interferometer. After the Start 

button is pressed one should wait on capturing the first measuring point. Then 

one should to move the retro-reflector base of about 100 mm and to wait on the 

next point capture. Announcements shown on the computer screen make the 

measurement easy. After capturing the last measuring point press Stop.  

If from some reasons will not be possible to move the retro-reflector base 

before the capture moment, the measurement should be repeated from the 

beginning point and possibly the measuring interval should be enlarged. 

 

            

FIG.6.6. A RESULT OF STREIGHTNESS MEASUREMENT 

 

To make the measurement in the manual capture of the measuring points, 

the Measurement automatic in panel Measurement should be switched off. 
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The measurement begins by pressing Start. The Capture of the measuring points 

can be done from the computer keyboard or by pressing the remote Strobe 

button. Each time after the movement of the retro-reflector base of about 

100 mm, measuring point should be captured. After capturing the last point Stop 

should be pressed. 

 The results of the measurements may be saved to a file or printed in 

dependence on the options chosen  in the menu File. 
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FLATNESS MEASUREMENTS 

 

 

 

 

Preparations 

 

The flatness measurement is done on the basis of straightness 

measurements of eight axes. From obtained data a flatness map is drown 

(fig.7.1.). 
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FIG.7.1. AN EXEMPLARY SURFACE FLATNESS MAP 



FLATNESS MEASUREMENTS 

7-2  www.statuspro.com    

Required measuring set consists of: a PC computer, a laser head with a 

power supply, a Tripod stand, two magnetic bases (UM1 and/or UM2), a 

Environmental Compensation Unit - (ECU)  SM1, basis sensors (T1, T2, T3), 

an angle interferometer IK1, an angle retro-reflector RK1 on a base P100 and 

two beam directing mirrors ZK1. 

The element set for the flatness measurements is shown on fig. 7.2. 

 

FIG.7.2. THE ELEMENT SET FOR THE FLATNESS MEASUREMENTS (IK1, RK1 ON 

P100 BASE AND ZK1) 

 

 

Alignment of optics for the flatness measurements 

 

The measurement of flatness consists of the measurements of deviations 

from straightness made along 8 axes. The measurement axes are set (in panel– 

Measurement->New Axis ) on a measured surface as shown on figure 7.3. On 

this figure are shown also: directions of measurements in the axes and margins 

that must be kept during measurements. 

RK1 
IK1 

ZK1 ZK1 
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FIG.7.3. THE MEASUREMENT AXES 

 

The measurements of deviations from straightness are made with angular 

optics as described in Chapter 6, Straightness measurements. Depending on the 

measurement axis, a different set of optical components is used and the 

alignment of the optical path is done in slightly different way. All flatness 

measurements are done with one laser head position, shown on Figure 7.3.  

The flatness measurements are performed in the option Flatness. chosen 

from the Main Menu. After setting proper base length (standard is 100mm) and 

machine data (Edit->Machine Data and Edit->Base Length), the Measurement 

button should be pressed. Than a measured axis should be chosen (fig. 7.3) and 

than the optical path should be adjusted (see below). After the straightness of a 

chosen axis is measured a next axis should be chosen – Measurement->New 

Axis (fig. 7.4) When all the axes are measured, Flatness Plot button should be 

pressed. The received flatness plot (fig. 7.1) may be saved, printed or exported 

to a text file (File->Save, File->Print or File->Export). 
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FIG.7.4. CHANGING AXIS IN FLATNESS MEASUREMENT 

 

Optical path alignment in the axis “1”. 

The straightness measurement in the axis “1” is done with the optical 

components and in the way described in Chapter 6, Straightness measurements. 

 

 

Optical path alignment in the axes: “3”, “6”, “8”. 

 

During flatness measurements in the axes “3”, “6” and “8” an additional 

beam directing mirror ZK1 is used. The way of using it is shown on Figure 7.5. 
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FIG.7.5. THE SET OF THE OPTICAL COMPONENTS USED IN STRAIGHTNESS 

MEASUREMENTS IN THE AXES: “3”, “6:” AND “8” 

 

 

1. The diaphragm on the laser head set to the Alignment position, 

2. The beam directing mirror ZK1 set 45
o
 to the laser beam coming out 

from the head, 

3. Place the angle interferometer IK1 in the measured axis, 

4. Set the diaphragm on the angle interferometer to the Alignment 

position, 

5. Change the position of the head so that the beam falls in the middle of 

upper interferometer’s diaphragm, 

6. Set the diaphragm on the angle retro-reflector to the Alignment 

position 
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7. Moving the retro-reflector along the axis, change the position of the 

head so that the beam passing through the interferometer falls also in 

the middle of the retro-reflector’s diaphragm, 

8. After changing the positions of the diaphragms on the interferometer 

and on the retro-reflector to Working positions, check if the return 

beam falls in the middle of measuring opening in the head. Do the 

check moving the retro-reflector along the axis. Corrections, if needed, 

can be made both changing the head or the interferometer position, 

9. Set the diaphragm on the laser head to Working position and check if 

the level indicator on the display shows around 100%, 

10. Now the straightness measurements, as described in Chapter 6, can be 

made. 

 

 

Optical path alignment in the axes: “5” and “7” 

 

During flatness measurements in the axes “5” and “7” two beam directing 

mirrors ZK1 are used. The way of using them is shown on Figure 7.6. 
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FIG.7.6. THE SET OF THE OPTICAL COMPONENTS USED IN STRAIGHTNESS  

MEASUREMENTS IN THE AXES: “5” AND “7” 

 

 

1. The diaphragm on the laser head set to the Alignment position, 

2. The first beam-directing mirror ZK1 set 45
o
 to the laser beam coming 

out from the head. The position of the laser head should be regulated in 

a way that the beam reflected from the first mirror runs parallel to the 

axis “3” and falls on the second beam-directing mirror. The second 

mirror is set 45
o
 to the first one, 

3. Changing the position and the angle of the second mirror direct the 

reflected beam along the axes “5” or “7” in a way the beam is parallel 

to the axis, 
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4. Place the angle interferometer in magnetic holder of the second mirror 

and set it in the optical path, 

5. Set the diaphragm on the angle interferometer to the Alignment 

position, 

6. Change the position of the head so that the beam falls in the middle of 

upper interferometer’s diaphragm, 

7. Set the diaphragm on the angle retro-reflector to the Alignment 

position, 

8. Moving the retro-reflector along the axis, change the position of the 

head so that the beam passing through the interferometer falls also in 

the middle of the retro-reflector’s diaphragm, 

9. After changing the positions of the diaphragms on the interferometer 

and on the retro-reflector to Working positions, check if the return 

beam falls in the middle of measuring opening in the head. Do the 

check moving the retro-reflector along the axis. Corrections, if needed, 

can be made both changing the head or the interferometer position, 

10. Set the diaphragm on the laser head to Working position and check if 

the level indicator on the display shows around 100%, 

11. Now the straightness measurements, as described in Chapter 6, can be 

made. 

 

Optical path alignment in the axes: “2” and “4” 

 

Similar to previously described, during flatness measurements in the axes 

“2” and “4” two beam directing mirrors ZK1 are used. The difference is that the 

angle of the second mirror usually differs from 45
o
. The way of using them is 

shown on Figure 7.7. 

 



FLATNESS MEASUREMENTS 

7-9  www.statuspro.com    

FIG.7.7. THE SET OF THE OPTICAL COMPONENTS USED IN STRAIGHTNESS 

MEASUREMENTS IN THE AXES: “2” AND “4” 

 

1. The diaphragm on the laser head set to the Alignment position, 

2. The first beam-directing mirror ZK1 set 45
o
 to the laser beam coming 

out from the head. The position of the laser head should be regulated in 

a way that the beam reflected from the first mirror runs parallel to the 

axis “3” and falls on the second beam-directing mirror. The second 

mirror is set in the necessary angular  to the first one, 

3. Changing the position and the angle of the second mirror direct the 

reflected beam along the axis “4” in a way the beam is parallel to the 

axis, 

4. Place the angle interferometer in magnetic holder of the second mirror 

and set it in the optical path, 
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5. Set the diaphragm on the angle interferometer to the Alignment 

position, 

6. Change the position of the head so that the beam falls in the middle of 

upper interferometer’s diaphragm, 

7. Set the diaphragm on the angle retro-reflector to the Alignment 

position, 

8. Moving the retro-reflector along the axis, change the position of the 

head so that the beam passing through the interferometer falls also in 

the middle of the retro-reflector’s diaphragm, 

9. After changing the positions of the diaphragms on the interferometer 

and on the retro-reflector to Working positions, check if the return 

beam falls in the middle of measuring opening in the head. Do the 

check moving the retro-reflector along the axis. Corrections, if needed, 

can be made both changing the head or the interferometer position, 

10. Set the diaphragm on the laser head to Working position and check if 

the level indicator on the display shows around 100%, 

11. Now the straightness measurements, as described in Chapter 6, can be 

made. 

 

In the case of the measurements in the axis “2”, the path alignment 

procedure is the same as described above. The only difference is that the second 

mirror, as not needed, is not used. 
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  STRAIGHTNESS MEASUREMENTS – 3D 

 

 

 

 

Straightness/squareness  measurement highlight any bending component or 

overall misalignment in the guideways of a machine. This could be a result of a 

wear in the guideways, an accident or poor machine foundations. The 

straightness/squareness errors are a direct effect of a machine geometry and their 

elimination increases machining accuracy. The quick assessment of the machine 

geometry is one of the most important action required when the machine is 

mounted on the foundation.  

The geometry measurements are one of the most time consuming 

measurements. There are three methods of straightness measurement: with 

angular optics, with Wollastone prism and with 3D method patented by 

Lasertex. The commonly used Wollastone prism optics is expensive and very 

difficult to adjust although it gives the most accurate results. Operation of the 

system with the Wollastone prism optics requires highly skilled personnel. The 

method with the angular optics was presented in the section ANGULAR 

MEASUREMENT (see Chapter 6).  

The optics for the Wollastone prism and the angular method are supplied 

optionally. The method of straightness measurement does not require any 

additional optics – the standard linear set is used.  

For squareness measurement one additional optical element is necessary – 

the optical square etalon (supplied optionally).  
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The straightness of the movement is measured by measuring the position of 

the reference beam and the position of the measuring beam returning to the laser 

head. 3D measurements offer unique possibility of measurements of straightness 

in two dimension in one measurement. This significantly shortens the 

measurement time.  

One could measure the straightness in Straightness option chosen from the 

main menu. For 3D measurements one have to choose the 3D method of 

measurement from the “Measurement” menu or from the Config menu (on the 

main screen). The straightness measurement software procedure are the same 

like for straightness measurements described in “ANGULAR 

MEASUREMENT” section. In Fig. 8.1 the print screen made during the 

measuring process is presented. The automatic option of the measurement was 

chosen. In the left black rectangle one can see the position of the retro-reflector 

in mm, while in the upper and lower black rectangle the horizontal and vertical 

shift in micrometers. 

 

 

FIG. 8.1. THE PRINT SCREEN OF STRAIGHTNESS MEASUREMENT 
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     The result of the measurements are presented in Fig.8.2. The upper trace 

shows the straightness for the horizontal axis and the lower one the straightness 

of the vertical axis. The parameter Ds represent the straightness error. End point 

fit method was chosen for plotting the result and for calculating of the 

straightness error.  

 

 

FIG. 8.2 THE RESULTS OF STRAIGHTNESS MEASUREMENTS 

 

       The accuracy of the straightness measurements depends on the precision of 

the alignment of the measured axis. It is recommended that the position of the 

crosses during alignment (as seen on the Display screen) procedure to be set to 

the center of the screen (zero position).Vibrations of the base where the tripod is 

placed and air density fluctuations are the source of noise that lower accuracy of 

the measurement. When required accuracy of straightness measurement for 

tested machine is not satisfactory one have to proceed to measurements with the 

use of angular optics or with the Wollastone prism.  
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Squareness measurements 

 

FIG.8.3. SQUARENESS MEASUREMENT RESULTS 

 

Procedure of measuring the squareness of the machine’s axes: 

a. Set up the laser head at a certain position; 

b. Measure the straightness of the movement in the first axis 

according the previous described procedure. Straightness can be 

measured with the Wollastone or the 3D method. 

c. Store obtained results. 

d. Measure the straightness of the movement in the second axis 

according the previous described procedure. Use the optical 

square etalon. Do not move the laser head!!! Any shift of the 

laser head position requires restarting the procedure from point 

1). 

e. Store obtained results. 
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f. Choose Edit->Squareness option. The window like the one 

shown on the Fig. 8.3. 

g. Load stored results and choose the squareness of which axes is 

of interest (i.e. Horizontal or Vertical). 

h. Calculated angle is shown in the bottom part of the window. 
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 VIBRATION MEASUREMENTS 

 

 

 

 

 

The laser measurement system µLine F1 is capable of detecting machine 

vibrations in the frequency range from 0 to 500 Hz. For these measurements an 

element set for linear measurements is used i.e.: a PC computer, a laser head 

with a power supply, a stand Tripod, magnetic holders (one UM1 and one 

UM2), a linear interferometer IL1, and a linear retro-reflector RL1.The 

Environmental Compensation Unit - (ECU)  and the temperature sensors do not 

have to be used. The optical path should be adjusted as shown in Chapter 4. 

To obtain correct results, a point of attaching the retro-reflector to the 

corpse of a measured machine must be carefully chosen. If the point is chosen 

improperly than, instead of a sought frequency f, a multiple frequencies n*f 

appear (where n=1,2,...) on the FFT chart. For that reason the retro-reflector 

must not be in theses measurements used with the magnetic holder UM1. It 

must be also remembered that the system measures the vibration only in the axis 

of the optical path. Any vibrations in perpendicular axes do not influence the 

measurement (see fig.8.1). An example of a properly attached retro-reflector is 

shown on fig. 8.2. 
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FIG.8.1. VIBRATION MEASUREMENT IN DIFFERENT AXES 

                

FIG.8.2. EXAMPLE OF PROPERLY ATTACHED RETRO-REFLECTOR 
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Measurements 

 

After adjusting the optical path and choosing FFT option from Main 

Menu a window, as shown on fig.8.3 appears. The most important parts of this 

window are: time diagram, frequency diagram and radio buttons (on the right 

side). Before measurements a machine data may be set (Edit->Machine Data). 

The measurement starts after pressing the Measurement button. Then appears 

the Measurement Window (see fig.8.3) that shows two progress bars – the upper 

(blue) one shows the progress in measurement; the lower (green) one shows 

progress in sending data to the computer. The measurement is in progress when 

the upper bar is in the range of 0-100% (it lasts approx. 12s)! 

            

FIG.8.3. VIBRATION MEASUREMENT WINDOW 

 

When both the measurement and the transmission are done, the 

measurement results are presented on the time diagram and its FFT analysis on 

the frequency diagram (fig.8.4). The results can be saved, printed or exported 

(menu File). With the use of radio buttons the type of input data may be chosen, 

i.e. whether amplitude of Distance, Velocity or Acceleration is important. In the 
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frequency diagram not only the amplitude of vibration frequencies may be 

displayed, but also their phase, real and imaginary part of the vibration. The 

check radio buttons in the bottom right of the window allow to change the 

vertical scale of the frequency diagram to logarithmic and to eliminate a DC 

offset. 

         

FIG.8.4. EXAMPLARY VIBRATION MEASUREMENT RESULTS 

 

What may be confusing in obtained results are different amplitudes of 

frequencies on the frequency diagram after changing from Distance to Velocity 

and to Acceleration, fig. 8.5. It happens so, accordingly to the theory, from 

which results: 

EAn ~ fn * EVn 

EDn ~ fn * EAn 

 Where: 

      EDn – amplitude of n-th frequency when Distance is chosen; 

      EVn – amplitude of n-th frequency when Velocity is chosen; 

      EAn – amplitude of n-th frequency when Acceleration is chosen. 

       fn – n-th frequency. 
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FIG.8.5. DIFFERENT FREQUENCIES’ AMPLITUDES IN DEPENDANCE ON 
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TECHNICAL DATA 

 

 

 

 

System specifications 

 

 

Measurement Range Resolution Accuracy 

Distance 0 – 30 m 0,01 µm  (0,001 µm) 1,5 µm/m 

Velocity 0 – 0,3 m/s  (0,1 m/s)
* 

0.25 µm/s 0,1 % 

Angular 0 – 3600 arcsec 0,04 arcsec ± 0,2 % 

Straightness measurement 

(with angular optics) 

0 – 12 m 0,02 µm (for 100 mm 

base) 

± 1 % 

Flatness 
0 – 12 m 

Vertical range ±2 mm 

0,02 µm (for 100 mm 

base) 

± 0,5 % 

Straightness measurement 

(with wollastone prism) 

0 – 3 m 0.5 µm 
± 1 %±(0.5±0.15L

2
) 

µm  

Straightness measurement 3D  0-5 m 0,1 µm (5± 1 x L) µm 

L in meter 

Squareness  ± 1000 arcsec 0,4arcsec ± 1 %  ± (1,5 arcsec) 

Rotary measurements ± 5 ° 0,04 arcsec ± 0,2 % 

L = axis length in meters 

* - for resolution 1 nm. 
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Laser head 

Laser type 
Zeeman HeNe laser with frequency 

stabilization 

Heating time Approx. 20 min 

Wavelength (vacuum) 632,991354 nm 

Wavelength accuracy ± 0,02 ppm 

Short time stability ± 0,002 ppm (1 hour) 

Output power  400 µW 

Beam diameter 8 mm 

Distance between out- and ingoing beam 12,7 mm 

Laser head dimensions 60x60x245 mm 

Net weight 1500 g 

Safety class 
Class 2 Laser product according to PN-

91/T-06700 

 

 

System work conditions 

Temperature range 10 – 35 °C 

Humidity range 10 – 90 % 

 

Power supply 

 

 

PC interface 

Type Bluetooth, USB 

Data rate 57 600 bps (RS 232) 

 

Voltage 90-230 VAC, 50-60 Hz 

Power 
35 W (during heating) 

10 W (work) 



TECHNICAL DATA 

10-3  www.statuspro.com   

 

Environment compensation 

   

 Wavelength compensation 

Manual Environments parameters entered from 

keyboard 

Automatic With the use of the Environmental 

Compensation Unit - (ECU) . 

 

Parameters of the Environmental Compensation Unit - (ECU) compensation 

Air temperature Range 0 – 40 °C, accuracy 0,1 °C 

Pressure Range 940 – 1060 hPa, accuracy 1 hPa 

Humidity Range 10 – 90 %, accuracy 10 % 

Time constants Temperature 3 s, pressure 2s, humidity 30 s 

Dimension φ50x55 mm 

Net weight 100 g 

 

 

 Material temperature compensation 

Manual Temperature of material entered from 

keyboard 

Automatic With the use of 1 to 3 temperature sensors . 

Temperature sensor Pt-1000 in oil resistant casing. 

Time constant 5 s 

Net weight 50 g 

 

Our products are subject to continuous further development and improvement. 

Subject to technical changes without prior notice. 

 

 


